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To establish a new ACH payment
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Sign in to Business Online. The system displays Business Online.

Select Payments & Transfers. The system displays the Payments & Transfers page.

Select ACH. The system displays the ACH transfer page.

Select + New payment. The system displays the New payment dialog box.

Select the appropriate Type (for example, Payroll - PPD) from the drop-down list. Click Continue.
The system displays the New payment page.

Type the Description of the transfer (for example, Monthly Payroll).

Select the tax identification number that the system associates with the transfer from the Tax
identification number drop-down list.

Note: In some instances, the system associates an ACH user (for example, George Washington)
with multiple companies (for example, Washington Farms and Washington Orchards). In these
cases, the system populates the Tax identification number drop-down list with each of the
companies that it associates with the user.

In the Effective date field, type the date you intend the new ACH transfer to process.
Select the Repeat check box to establish the frequency with which the new ACH transfer occurs.
Select the Frequency from the drop-down list to establish how often the transfer occurs.

Note: When you select a recurring frequency value other than None, the system populates the
transfer with an additional date field titled End date. Type the end date of a recurring transfer
as the End date.

Type the Company description.

In the Pay from section, select the appropriate Account from the drop-down list and type the
Amount that the system debits from the account.

In the Pay to section, complete the following:

Type the Name of the recipient.

Type the Identification number of the recipient (Optional)

Type the Routing transit number of recipient.

Type the Account number of the recipient.

Select the appropriate Account type.

Type the Amount to deposit in the recipient's account.

Click Complete ACH, the system displays the processing results page.
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To establish a new ACH collection

1. Select Payments & Transfers. The system displays the Payments & Transfers page.

2. Select ACH. The system displays the ACH transfer page.

3. Select + New collection. The system displays the New collection dialog box.

4. Select the appropriate Type (for example, Prearranged payment- PPD) from the drop-down list.
Click

5. Continue. The system displays the New collection page.

6. Type the Description of the transfer (for example, Monthly service contract).

7. Select the tax identification number that the system associates with the transfer from the Tax
identification number drop-down list.

Note: In some instances, the system associates an ACH user (for example, George Washington)
with multiple companies (for example, Washington Farms and Washington Orchards). In these
cases, the system populates the Tax identification number drop-down list with each of the
companies that it associates with the user.

8. Inthe Effective date field, type the date you intend the new ACH transfer to process.
9. Select the Repeat check box to establish the frequency with which the new ACH transfer occurs.
10. Select the Frequency from the drop-down list to establish how often the transfer occurs.

Note: When you select a recurring frequency value other than None, the system populates the
transfer with an additional date field titled End date. Type the end date of the recurring
transfer.

11. Type the Company description.

12. In the Pay from section, select the appropriate Account from the drop-down list and type the
Amount that the system debits from the account.

13. In the Pay to section, complete the following:

14. Type the Name of the recipient.

15. Type the Identification number of the recipient (Optional)

16. Type the Routing transit number of recipient.

17. Type the Account number of the recipient.

18. Select the appropriate Account type.

19. Type the Amount to deposit in the recipient's account.

20. Click Complete ACH, the system displays the processing results page.
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To inquire into an ACH payment or collection

Select Payments & Transfers. The system displays the Payments & Transfers page.

Select ACH. The system displays the ACH transfer page.

Type search criteria as needed then click Submit. The system displays a list of transfers on the
ACH Activity page.

4. Locate the ACH transfer that you want to inquire into and click the down arrow next to the
transfer to view a brief overview of the transfer.

5. Locate the ACH transfer that you want to inquire into and click on the Description hyperlink that
the system associates with that particular transfer. The system displays the ACH transfer details
page.

6. Review the ACH transfer. Complete steps 7 through 10 as needed.

7. Togenerate a report, click Report. They system displays the Transfer report dialog box.

8. Select PDF (.pdf) or Comma separated value (.csv) from the Format drop-down list and click
Download report.

9. Click Return to ACH activity. The system displays the ACH Activity list page.

To modify an ACH payment or collection

Select Payments & Transfers. The system displays the Payments & Transfers page.
Select ACH. The system displays the ACH transfer page.

3. Click Edit for the appropriate transfer from the list. The system displays the edit page for the
transfer.

4. Inthe Description field, modify the name of the transfer as needed (for example, Wash
Orchards Payroll becomes Wash Orch Pay).

5. Select the tax identification number that the system associates with the transfer from the Tax
identification number drop-down list.

6. Type the date that you intend the ACH transfer to process in the Effective date field.

7. Modify the frequency with which the ACH transfer occurs in the Frequency field.

Note: When you select a recurring frequency value other than None, the system populates the
transfer with an additional date field titled End date. Type the end date of the recurring
transfer.

8. Modify the description according to your needs in the Company description field.
9. Modify the information in the fields populating the Pay from section and the Pay to section as

needed.
10. Click Complete ACH. The system displays the confirmation page.



CAPITAL ACH User Guide for Business Online Banking

BANK I

PARTNERS in YOUR VISION

To Review and Approve an ACH transfer

Select the Home Page scroll down to the Payments & Transfers section.

Select Review, the system displays the transfers pending Approval.

Locate the ACH transfers that require review, click on the transfer description to display details.
Select Approve or Disapprove.

Note: You can approve or disapprove all of the ACH transfers displayed by selecting the
Description check box.

Description

TEST TEMPLATE

To delete an ACH transfer

Select Payments & Transfers. The system displays the Payments & Transfers page.
Select ACH. The system displays the ACH transfer page.
Use the Search activity fields to narrow the list of ACH transfers that the system returns.
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Click Delete next to the appropriate transfer. The system displays the Delete transfer page
a. Recurring ACH Transfers Only: Select the appropriate value from the Deletion type
drop-down list- Delete this Transfer or Delete All Transfers.
5. Click Delete ACH. The system displays the processing results page.

Note: If a transfer has already been processed by the Bank, it may not be
available to delete. If the Delete button is not displayed next to the transfer
contact the Bank for assistance.
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Establish a New ACH Transfer Using an Existing ACH Transfer

Select Payments & Transfers. The system displays the Payments & Transfers page.
Select ACH. The system displays the ACH transfer page.
Locate the appropriate transfer that you want use and click Copy. The system displays the
transfer name page.

4. In the Description field, type the name of the new transfer (for example, Wash Orchards
Payroll).

5. Select the tax identification number that the system associates with the transfer in the Tax
identification number drop-down list.

6. Type the date that you intend the new ACH transfer to process in the Effective date field.
For recurring transfers select the Repeat check box to define the Frequency that the transfer
occurs, and the End date.

7. Review the information in the Transfer from section and the Transfer to section, make changes
as necessary.

8. Click Complete ACH. The system displays the processing results page.

9. Click Return to ACH activity to return to the ACH Activity list or click Save as template to initiate
the process of establishing a new template based on the transfer that you just established.

Generate PDF formatted reports for ACH templates

Select Payments & Transfers. The system displays the Payments & Transfers page.
Select ACH. The system displays the ACH transfer page.

Click the Templates tab. The system displays a list of templates.

Click the Report button. The system displays the

Template report dialog box.
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Select the appropriate check boxes for the templates that you want to include in the report,

select PDF (.pdf) from the Format drop-down list and click

7. Download report. When the system prompts you, select the local folder to which you want to
save the formatted report.

8. Once you save the PDF formatted report, open the report in Adobe Reader. The system displays
the PDF formatted report for the ACH template.

9. When you complete your review of the report, close
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Generate CSV formatted reports for ACH transfers

Select Payments & Transfers. The system displays the Payments & Transfers page.
Select ACH. The system displays the ACH transfer page.
Use the search criteria to narrow the list of transfers and click Search. The system refreshes the
page with the new search results.

4. Click Report to generate a report for all items that the system displays. The system displays the
Activity report dialog box.

5. Select the appropriate Type check boxes (for example, File information, Batch information, or
Transactions) for the information that you want the system to include in the report.

6. If you select more than one Type check box, the system compiles the report in a Zip file.

7. Select Comma separated values from the Format drop-down list.

8. Click Download report. When the system prompts you, select the local folder to which you want
to save the formatted report.

9. Once you save the CSV formatted report, open the report in a program like Microsoft Excel. The
system displays the CSV formatted report for the ACH transfer.

10. When you complete your review of the report, close the report.

Import a NACHA file formatted transfer using an existing template

1. Select Payments & Transfers. The system displays the Payments & Transfers page.

2. Select ACH. The system displays the ACH transfer page.

3. Click the Import file hyperlink. The system displays the Import file page.

4. Select NACHA as the Import type.

5. Inthe File location field, select Browse. The system displays the Choose File to upload window.
6. Select the file to upload and click Open. The system displays the Import file page.

7. Select the appropriate Template from the drop-down list.

8. Click Continue. The system displays the File summary page.

9. Click the Review ACH button. The system displays the transfer Activity edit page.

10. Review the transfer details and make any desired changes, and then click Complete ACH. The

system displays the confirmation page.
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Import a Non-NACHA formatted transfer using an existing template

Select Payments & Transfers. The system displays the Payments & Transfers page.

Select ACH. The system displays the ACH transfer page.

Click the Import file hyperlink. The system displays the Import file page.

Select Non-NACHA.

In the File location field, select Browse. The system displays the Choose File to upload window.
Select the file to import and click Open. The system displays the Import file page.

Select the appropriate Template from the drop-down list.

Click Continue. The system displays the New
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NACHA file import template page.
. Review the content. If the system prompts you, type the Effective date and click Continue. The
system displays the Import file [File Name] page.
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11. Click Complete ACH. The system displays a status message about the imported file.
12. Click Return to ACH activity.

Import a NACHA file without using a template

Select Payments & Transfers. The system displays the Payments & Transfers page.

Select ACH. The system displays the ACH transfer page.

Click the Import file hyperlink. The system displays the Import file page.

Select NACHA.

In the File location field, select Browse. The system displays the Choose File to upload window.
Select the file to import and click Open. The system displays the Import file page.

Select Import without using a template from the Template drop-down list.

Select the tax ID number from the Tax identification number drop-down list.
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Select the appropriate ACH transfer type from the Type drop-down list.
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. Click Continue. The system displays the Import file.
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. Click Review ACH. The system displays the transfer Activity edit page.

[E
N

. Review the transfer details and make any desired changes, and then click Complete ACH. The
system displays the confirmation page.
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Import a Non-NACHA file using a new template

Select Payments & Transfers. The system displays the Payments & Transfers page.
Select ACH. The system displays the ACH transfer page.

Click the + Import file hyperlink. The system displays the Import file page.

In the Import file section, complete the following:

Select Non-NACHA.

Select the File location using the Browse button.

Select Create a new template from the Template drop-down list.

Select the ACH transfer type from the Type dropdown list.

Click Continue. The system displays the Import file page with all the import details.
Complete the following:
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10. Type the Template name.

11. Select the Tax identification number from the drop-down list.

12. Select the Template group from the drop-down list.

13. Select the appropriate Insert decimals into amounts option.

14. Select Delimited or Fixed width as the file format.

15. Type the number of Header and Footer rows to exclude.

16. Select the Text qualifier from the drop-down list.

17. Select all appropriate Column options.

18. In the Apply additional values section select the appropriate Type from the drop-down list.

19. In the Offset account options section, select whether you want the system to apply an offset.

20. In the Effective date section, select whether the system use the Date in file, Prompt for date, or
the Default current business date.

21. Inthe User access section, select either All current and future users or Specific users.

22. Click Continue. The system displays the Import file - [Template Name] page which provides an
overview of the data mapping.

23. Type the Effective date and click Continue. The system displays the File summary page.
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Review ACH templates

Select Administration.

Select the ACH Template Tab.

Use the Search activity options (for example, Template type) to locate templates that need
approval.

4. Select the check-box for the appropriate template that needs approval and click Approve. The
system displays the ACH Template administration page and adds the approved template to the
list of Approved templates.

5. Optional. Click the Print icon to print the list of templates that need to approval.

Establish a new ACH transfer template

Select Payments & Transfers. The system displays the Payments & Transfers page.

Select ACH. The system displays the ACH transfer page.

Click the Templates tab. The system displays a list of available templates.

Click + New payment template. The system displays the New payment template dialog box.
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Select Payroll - PPD from the Type drop-down list and click Continue. The system displays the
New Template page.
6. Note: We use the Payroll - PPD as an example only.

Complete the following:

Type a Template name.

Select the Tax identification number from the drop-down list.

Select the Template group from the drop-down list.

Select the Repeat check box if the template is for recurring transfers.
Type the From amount.

Type the To amount.

Select the Frequency from the drop-down list.

In the User access section, complete the following:
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To enable the template for all users select All current and future users.
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. To enable the template for specific users, select Specific users. Select the appropriate check
boxes for each user that you want to have access to the template.
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In the Pay from section, complete the following:

1. Optional. Type the Account number to filter by the account number of the Originating
Depository Financial Institution (ODFI).

2. Optional. Type the Amount to filter by the amount to be paid from the specified accounts to be
debited.

3. Optional. Type the Identification to filter by the identification number that the system
associates with the originator of the transfer.

4. Optional. Type the Name, to filter by the name of the customer that the system associates with
the account it debits from.

5. Optional. Click the Pay all switch to turn on the Hold option for all transfers in the batch.

6. Type the Identification.

7. Type the Name.

8. Optional. Type any Discretionary data.

9. Optional. Type the Payment information to include notes about the transfer.

10. In the Pay to section, complete the following:

11. Type the Name of the recipient.

12. Type the Identification number of the recipient.

13. Type the Routing transit number of recipient.

14. Type the Account number of the recipient.

15. Select the appropriate Account type from the drop-down list.

16. Type the Amount to deposit in the recipient's account.

17. Select the appropriate Template Group from the dropdown list.

18. Click Save.

Edit an ACH transfer template

Select Payments & Transfers. The system displays the Payments & Transfers page.
Select ACH. The system displays the ACH transfer page.
Click the Templates tab. The system displays a list of available templates.
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Click Edit for the template that you want to edit. The system displays the Edit template dialog

box.

5. Inthe Description section, modify the Template name, Template group, From account, and To
amount as needed.

6. Inthe User access section, modify any user access specifications as needed.

7. Modify the information in the fields populating the Pay from section and the Pay to section as
needed.

8. Click Save.
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Delete a transfer template

Select Payments & Transfers. The system displays the Payments & Transfers page.

Select ACH. The system displays the ACH transfer page.

Click the Templates tab. The system displays a list of available templates.

Click Delete for the template that you want to delete. The system displays the delete Template
page for the template that you specified.

5. Click Delete Template. The system displays the Templates page.
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